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Introduction

1.1

What is SimFlex™ HMI Simulator?

The SimFlex™ IEC 61850 HMI Simulator is meant to simulate a subset of SCADA or HMI functions.
These functions are, amongst others, connecting to IEDs that are defined in an SCD file, configure
and enable report control blocks, enable GOOSE control blocks and perform control actions (SBOw,
Direct operate)

1.2

Benefits

The main benefits of using the SimFlex™ HMI Simulator are:
•
•
•

1.3

Clear overview on distinctive data in IEDs.
Distinct representation of changing values.
Display multiple IEDs simultaneously.

Applications

The SimFlex™ HMI Simulator has a wide range of applications.
•
•
•
•

1.4

View data values from devices.
Capture reports and monitor value changes.
Send control requests on controllable objects.
File transfer; download from and upload to devices.

Key Features

The SimFlex™ HMI Simulator:
•
•
•
•
•
•

Is able to configure all report control blocks in any IED with the default values from the SCD
file.
Can enable all report control blocks in any IED.
Is able to connect to at least 32 IEDs simultaneously.
Is able to load JPG/PNG files with single line diagrams and show these graphics on the screen
as a static picture.
Is able to retrieve all LD, LN, DO and DA information from each IED in the tree-view and show
the data model of each IED in a Windows tree-view.
Can enable all GOOSE control blocks in any IED.

The SimFlex™ HMI Simulator provides a simple graphical user interface (GUI) for monitoring and
handling IEC61850 data from servers. Many of the features of the program are available through an
intuitive tool bar.

1.5

Basic skill requirements

The SimFlex™ HMI Simulator has been designed to be user-friendly. The GUI is showing the most
important functions that the average user needs in daily use. The program is therefore easy to learn.

1.6

SCL file requirements

The SimFlex™ HMI Simulator can only run properly if the SCL file (a file that meets the IEC61850
Substation Configuration Language) is correct. SimFlex™ HMI Simulator only reports some basic
errors that might be in the SCL file. For fast and accurate automated verification of SCL files,
GridClone offers the SimFlex™ SCL Checker.

1.7

Network traffic

The SimFlex™ HMI Simulator uses network messages to communicate with the server and capture
reports. To analyze network traffic, GridClone offers the SimFlex™ Protocol Analyzer for fast and
flexible capturing of network traffic from IEC 61850 based clients and servers (IEDs).

2

SimFlex™ HMI Simulator overview
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After startup of the application the main window is shown (see Figure 2.1). The main window has the
following sections:
1) The Program Menu; most program functions can be accessed from this menu.
2) The Tool Bar; the tool bar provides quick access to frequently used functions.
3) The Scheme Picture Box; this view shows the SLD image that is used as background along
with the nodes that are dragged from the IED panel.
4) IED Panel; this tree shows the SCL file and all of its nodes.
5) Status Bar.

1
2
4
3

5
Figure 2.1: SimFlex HMI Simulator main form

2.1

Menu items

The following menu items are available:

Each menu item is described in the next chapters.
2.1.1

Menu – File

In the File menu the most common file actions can be executed:
•

New HMI Project Ctrl+N – Resets the SLD image to GridClone background and closes SCL file.

•

Open
o Open HMI Project Ctrl+O – opens a previously created HMI Project file (chapter 4).
o Open SLD Image
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o Open SCL File
Ctrl+Alt+O – opens a file that meets the IEC61850 Substation
Configuration Language. A Data model is built using the IEC61850 version + revision
as defined in the SCL file. The nodes will be expanded up to Logical Device level,
except for IED nodes that don’t have an IP address.
•

Open Recent – opens one of the most recently opened HMI project files (chapter 4).

•

Save
o Save HMI Project Ctrl+S – saves the HMI project (see chapter 4).
o Save HMI Project As – saves the HMI project with a different file name.

•
2.1.2

Exit – closes the program.
Menu - Edit

In the Edit menu the following actions can be executed:
•

Settings – opens the application settings dialog. For detailed information see chapter 3.

•

Pick Background color – after opening an SCL image, the background color is set to the upper
left pixel of it. Background color is used to extend the background image to the right and
bottom (if the image is smaller than the scheme picture box), as background of text that is
outside of the rectangle and for the color of the rubber band (transparent black for light
background or transparent white for dark background). This function enables to select
another pixel from the background image to use as background color.

2.1.3

Menu - Help

In the Help menu the following actions can be executed:
•

User Manual F1 – opens the on-line user manual. The on-line user manual is a Windows help
file that can be easily browsed using the available Contents, Index and Search tabs.

•

Show Log – shows the SimFlex HMI Simulator Log form modeless. This means that the main
form can be used while this form is shown. By default, the Log form is transparent when the
mouse is not hovering over. The opacity for this transparency can be changes by double-click
in the Log form. The Log Settings form will be shown. In this form, you can also check the
“Show Time” box to display the time for each logged line. When the “Auto scroll” box is
checked, the log form will automatically change the scrollbar to ensure the last line to be
visible. The form is listing the latest log data every half second, but there is a 3 second delay
starting at mouse up, so you have some time to copy selected text to the clipboard.

Figure 2.2: Log Settings

The text that is displayed is limited. When the maximum length of 200000 characters is
exceeded, the first 20% will be removed.
•

Open Log - opens the log file using the program that is selected to use for files having .log
extension.

•

About – opens the About dialog that shows information regarding the SimFlex™ HMI
Simulator (version number, copyright, etc.). In the About dialog there is a link to the
GridClone website and also a link to generate a standard email to the GridClone Support
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Team in case you have questions or comments regarding the product. Figure 2.3 shows an
example of the About dialog.

Figure 2.3: About SimFlex HMI Simulator

2.2

Toolbar items

The toolbar is fixed. It contains buttons that provides an easy way to handle the HMI Simulator:
2.2.1
•

Change Settings – opens the application settings dialog. For detailed information see
chapter 3.

•

Open HMI Project Ctrl+O – opens a previously created HMI Project file (see chapter 4).

•

Open SLD Image

•

•
•

Alt+O – opens an image to be used as background.

Open SCL File Ctrl+Alt+O – opens a file that meets the IEC61850 Substation Configuration
Language. A Data model is built using the IEC61850 version + revision as defined in the SCL
file. The nodes will be expanded up to Logical Device level, except for IED nodes that don’t
have an IP address.
Save HMI Project Ctrl+S – saves the HMI project (see chapter 4).
Read Data from Level – When date values are read, it is done in groups starting at the
level that is selected here. Using a high level (LD) will be quicker, but it could cause errors for
the packages might become too big. The Read Data Level is stored in the HMI Project file (see
chapter 4).

•

Start … – Connect all selected IEDs, read data values, start report capture.

•

Stop … – Stop report capture for all connected IEDs and disconnect.

•

Confirm all changes – set every node that has status changed to status confirmed
(unchanged).

•

Select all IED – Select all enabled IED nodes (an IED node is enabled if there is an IP address
defined in the SCL file).

•

Deselect all IED – Deselect and collapse all IED nodes.

•

Collapse all tree nodes – Collapse all nodes recursively.

•

2.3

Toolbar Buttons

Send support request - If you’re having trouble using SimFlex™ HMI Simulator, you can
send email to GridClone. To understand the condition of your problem, GridClone needs to
know the logs and configurations of your SimFlex™ HMI Simulator application. Using the
support feature will create a .zip file containing the information that is needed for support
and ask you to mail it to support@gridclone.com

Scheme Picture Box

This size of the background image defines the workspace. If the size exceeds the control size,
scrollbars will appear. If it is smaller, the background color is shown.
© 2014 GridClone B.V.
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The only way to place items in the scheme picture box is to drag them from the IED panel. A rubber
band will show a preview. When the mouse isn’t moved for 0.25 second, the rubber band will jump
to the position on the grid.
When the mouse rests for 0.25 seconds hovering over an item, a balloon is shown. It displays the
path of the node and, if available, its value and previous value.
2.3.1
•
•
•
•

Select items

Pick inside to select one. The corresponding node in the IED Panel will be selected as well and, if
needed, the node will be expanded and the scrollbar will be changed to ensure its visibility.
Pick outside item to start a crossing. All items that have the center within the crossing will be
selected.
Use “Ctrl” to add to selection.
Use “Ctrl + A” to select all items.

2.3.2

Move items

•

Pick inside an items rectangle to start move. All selected items will be moved. When the mouse
isn’t moved for 0.25 second, the rubber band will jump to the positions on the grid.

•

Use arrow key
to move all selected items one pixel. Items won’t be moved to grid points
when moved by arrow keys.

2.3.3

Resize items.

Resize is only available for one selected item. Pick inside an items rectangle near the right edge to
start resize. When the mouse isn’t moved for 0.25 second, the rubber band will jump to the position
on the grid.
2.3.4

Right click options

•

Delete – Remove selected items from scheme picture box. The nodes won’t be removed from
the IED panel. This action can be reverted by “Ctrl + Z”.

•

Confirm – Set every selected item that has status changed to status confirmed (unchanged).

•

Send Control Request – Only for Controllable Objects. See chapter 5.

•

Refresh – Read data values.

2.3.5

Key options

•

“Ctrl + A” – Select all items.

•

Arrow keys

•

“Delete” or “Ctrl + X” – Remove selected items from scheme picture box. The nodes won’t be
removed from the IED panel. This action can be reverted by “Ctrl + Z”.

•

“Ctrl + Z” – Undo last delete or move.

2.4

IED Panel

2.4.1

Display

– Move selected items one pixel.

This panel shows all IEC 61850 objects of the opened SCL file as nodes in a tree. The icons that are
used do indicate the type of node and its status:
SCL file.
IED (No IP address, Not selected, Selected, Connect failed, Connected)
© 2014 GridClone B.V.
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,

Logical Device (Unchanged or confirmed, Changed)

,

Logical Node (PTOC) (Unchanged or confirmed, Changed)

,

Logical Node (PTOV) (Unchanged or confirmed, Changed)

,

Logical Node (CSWI, XSWI or XCBR) (Unchanged or confirmed, Changed)

,

Logical Node (other) (Unchanged or confirmed, Changed)

,

Functional Constraint (Unchanged or confirmed, Changed)

,

Data Object (Unchanged or confirmed, Changed)

,

Data Attribute (or Type) (Unchanged or confirmed, Changed)

If attribute node has a value, “=” + the value will be displayed behind the node name.
If the value of a node (or one of its children) is changed, the icon will be red. If the change is within
the blink time (see chapter 3), the icon will be alternating red and black. The value that is displayed at
the red icon is the new value, the value at the black icon is the old value.
Nodes in the tree can be expanded or collapsed by the standard windows functionality (click the
“PlusMinus” or select and use “-”, “+” or “*” – key.
To collapse all tree nodes (recursive), there is a button in the toolbar.
2.4.2

Drag functionality

When a node is dragged (left mouse click, hold down and move), the cursor will change to dragging
hand or stop sign. If the dragging hand appears, the node can be dragged to and dropped in the
Scheme Picture Box. If it’s a Logical Device, all its Logical Nodes will be placed as well. If it’s an IED, all
its Logical Nodes are placed as well. The stop sign will appear if the node is already in the Scheme
Picture Box or if the node is not part of an IED.
2.4.3

Select functionality

When a node that has an item in the Scheme Picture Box is selected, this instance will be selected as
well and, if needed, the scrollbars will be changed to ensure its visibility.
2.4.4

Right click functionality

Depending on the type of node and the status, these options will be available and enabled:
•

Delete – Remove from scheme picture box.

•

Confirm – Set status to confirmed (unchanged).

•

Select – IED will be connected when “Connect selected IEDs” is pressed.

•

Deselect - IED will not be connected when “Connect selected IEDs” is pressed.

•

Send Control Request –See chapter 5.

•

File Transfer – Available for connected IED nodes. See chapter 6.

•

Refresh – Read data values. If refresh is started from a LD, LN or FC level, all DO from the
branch in the tree are refreshed.

•

File: – full path name of the HMI project file that is saved or opened.

•

Status – Show current activity (“Idle” if no activity to wait for)

•

Progress bar – Show progress of activity that is displayed.

2.5

Status Bar
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3

Configuring the SimFlex™ HMI Simulator

To configure the application, open the Settings dialog by selecting menu Edit
Settings.

Figure 3.1: Settings form

4

•

Application base directory - this is the base directory that is used to store HMI project files and
log files (in subfolder HMI_log).

•

Delete .log files after – this is the period the SimFlexError.log and the HMI.log files, that are
automatically created when SimFlex™ HMI simulator is started, will be deleted. If 0 is entered,
the .log files will never be deleted.

•

Blink time – Nodes that are changed will blink for the time that is set by this.

•

Blink interval – Blinking nodes’ representation will change after this period.

•

Grid Horizontal – Nodes that are dragged to the Scheme Picture box will be placed at a
multiplication of the pixels as specified here. The same goes for move and resize. If the grid is
changed and there are placed nodes that don’t match the new grid, the program will ask for
adjusting placed nodes to new grid.

•

Grid Vertical – See previous bullet.

HMI project

A HMI project is a stored collection of the settings as listed below:
•

Splitter distance.

•

Read Data Level.

•

Background image: The file that is opened as image to be used as background in the scheme
picture box. Only the full path of the file is stored, therefore the project is only exchangeable
when the image file is in the same directory.

•

Background color: The background color to use in the scheme picture box.

•

SCL file: The file that is opened as SCL file. Only the full path of the file is stored, therefore the
project is only exchangeable when the SCL file is in the same directory.

•

Items: A list of all nodes that are dragged to the scheme picture box, storing their position and
width.

•

IEDs: A list of all IED nodes in the SCL file, storing weather the IED is selected or not.

5

Controllable Objects
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A controllable object is a Data Object who’s parent is a Functional Constraint called “CO”. In the IED
Panel, it is marked by a yellow background color.
If a Logical Node contains only one Controllable Object, this Data Object can be selected from it. It is
marked by a yellow background color. If a Logical Node contains more than one Controllable Object,
it is marked by a pink background color.
Controllable Objects do have the right-click option “Send Control Request” (both in the Scheme
Picture Box and in the IED panel) that is enabled for connected IED’s.

Figure 5.1: Object Control form

The block on the top left shows the current state of the control.
On the right side, there are buttons to operate. Dependent on the object’s $CF$Pos$ctlModel value,
some of these buttons will be disabled. In this sample, the control is “sbo-with-enhanced-sequrity”
which means the “Select” button has to be pressed to enable the “Operate” button.
The detailed data that are not applicable for standard use are
not shown by default. To display them, you can press the “+”
button. This also displays the “Enable” button. This button
will enable all tiles. It enables expert users to test the devices
behavior on illegal input (like “Operate” without “Select” on
an “sbo-with-enhanced-sequrity” control).
•

“New ctlVal” is initiated on the opposite of the actual
status.

•

“Date Time” is initiated to current time the moment a
button is clicked.

Figure 5.2: Object Control form showing details

6

File Transfer

File Transfer enables you to download files from a connected IED. It can be started by right mouse
click on a connected IED node. All files are listed (folders are not listed). After making a selection
(multi-select is possible using Shift, Ctrl or Ctrl + A), the “DownLoad” button will be enabled.
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Figure 6.1: File Transfer form

When DownLoad is pressed, the directory to store the downloaded files can be changed.

Figure 6.2: File Transfer Browse download folder form

Alert! Existing files will be overwritten without asking.
When UpLoad is pressed, the file to upload can be selected. If opened, the filename on the IED has to
be set.

Figure 6.3: File Transfer UpLoad form

Alert! There is no check whether the IED supports SetFile or not. There is also no check for available
space on the IED. A message will be shown to inform if the SetFile succeeded or failed.

7

Frequently Asked Questions (FAQ)

This chapter provides some frequently asked questions and theirs answers. Check this section before
you contact GridClone for support on your question.

7.1

General

7.1.1

How to install the SimFlex™ HMI Simulator?

Read the Getting started document that comes with the program for a detailed description of the
installation procedure. If you do not have administrator rights on your PC, please contact your IT
department to initially install.
7.1.2

The HMI Simulator does not start or complains about the license

In the system tray check if the CodeMeter service is running (clicking on the small system-tray
arrow).
If the CodeMeter is not visible, it could be that it is not running, or that the service *is* running, but
the CodeMeter program is not visible.
a) In the first case: re-install the HMI Simulator and make sure the CodeMeter software installs
correctly.
b) In the second case: press Windows Start button and locate the CodeMeter installation. Then
start the “CodeMeter Control Center” manually.

© 2014 GridClone B.V.
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Once the CodeMeter Control Center is started, open it (from the system tray) and check that there is
a license shown in the left part of the dialog. Make sure you have inserted the USB license key in one
of the available USB ports!
In case you are running a trial version of the SimFlex™ HMI Simulator:
If there is no license shown, select File
Import License from the menu and locate the “*.lic” file in
the HMI Simulator folder (In the folder where you installed the program, e.g. C:\Program
Files\GridClone\...). Note that the CodeMeter Control Center might have a filter like “*.WibuCmRaU”.
Change it to “*.*” or “*.lic” to make the license file visible.
Once the license file has been selected and opened it should be visible in the CodeMeter Control
Center.
To be sure the license is activated: stop and start the CodeMeter Control Center service by pressing
Process
Stop CodeMeter Service and then Process
Start CodeMeter Service.
Finally re-start the HMI Simulator. If the problem persists please contact GridClone for support.

8

Additional Information

In this section you will find information on additional topics.

8.1

File name conventions

Any *.log file is either:
•

A file that contains the information that was logged to the Log View. These log files have the
following format:
[yyyy-mm-dd]_[hh.mm.ss]-HMI.log

•

The SimFlex™ HMI Simulator also stores information to disk in case problems occur in the
program. This information is stored in a so-called Error Log file. Error log files are always
needed by the GridClone Development Team for trouble shooting. These Error Log files have
the following format:
[yyyy-mm-dd]_[hh.mm.ss]-SimFlexError.log.

8.2

Used abbreviations

DA

Data Attribute

DO

Data Object

DUT

Device Under Test

FC

Functional Constraint

GOOSE

Generic Object Oriented System Event

GUI

Graphical User Interface

IEC

The International Electrotechnical Commission, managing international standards. See
also: http://www.iec.ch

IEC 61850

The IEC 61850 standard

IED

Intelligent Electronic Device

LD

Logical Device

LN

Logical Node

MMS

Manufacturer Message Specification, or ISO 9506

NIC

Network Interface Card
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UCA

The UCA® International Users Group. See also: http://www.ucaiug.org

OSI

Open Systems Interconnection. See also http://en.wikipedia.org/wiki/OSI_model

8.3

Referenced documents

IEC 61850
MMS

IEC 61850:2003

ISO 9506:2003 (as used by IEC 61850-8)

Getting started SimFlex HMI Simulator.pdf

8.4

Referenced tools

SCL Checker:

For conformance testing of an SCL file. This program is a member of the
SimFlex™ tool platform.

Protocol Analyzer: For capturing of network traffic from IEC 61850 based clients and servers (IEDs).
This program is a member of the SimFlex™ tool platform.

8.5

User Manual version history

Version

Date

By

Subject

1.0

February 28, 2014

WvE

Initial version
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